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1. Introduction to Kernel File Shredder

Welcome to the user manual for Kernel File Shredder, the most effective and convenient tool to destroy 
permanently deleted files and folders beyond recovery. This user manual comprises step by step 
guidelines on using Kernel File Shredder. 

 1.1  Using this Manual 

This user manual is intended to guide users on using Kernel File Shredder. We suggest that first time 
users should read this user manual completely and carefully before proceeding to use the software. 
However, if you are an experienced user, you can use the table of contents to find out information 
pertaining to the tasks that you need to perform by using Kernel File Shredder.  

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

Introduction 

Getting Started 

Software Interface 

Using Kernel File Shredder 

Other Shredding Options  

Full Version 

Support 

Troubleshooting 

Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 
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GB: Giga-Byte 

 2.1 About Kernel File Shredder 

Kernel File Shredder is an amazing, stunning, and professional data privacy software that has been 
designed to permanently delete (shred) files and folders beyond recovery. By using the phrase “beyond 
recovery,” we mean once the files and/or folders are shred using Kernel File Shredder software, none of 
the Windows Data Recovery tool will be able to recover them back in any case and by using any data 
recovery algorithm. 

Kernel File Shredder is also called data privacy tool, as it protects important data from being used in 
wrong manner. For example, after using some sensitive data, you have deleted the file so that no one can 
reuse it in a wrong way. In your knowledge, you have permanently deleted the file but in fact, that file can 
be recovered using Windows Data Recovery software because the file is deleted not shredded. And if the 
file is recovered by any wrong person then consequences can be dangerous. To avoid such situations, 
using Kernel File Shredder is recommended so that the deleted file cannot be recovered again.  

Kernel File Shredder permanently removes the files and folders from computer’s hard disk making them 
unfeasible to recover. While shredding files and folders, the software overwrites the file’s content using file 
shredding algorithm making the file content useless, renames the files, and then removes it permanently 
from hard disk.  

The software incorporates eleven file shredding algorithms from which the user can select the required 
one from the simplest Zeroes (1 pass) algorithm to the toughest DoD 5220 + Peter Gutmann file shredding 
algorithm.  



Note: Kernel File Shredder is designed to shred files available on computer’s hard 
disk. Data stored on any other storage media like network drive, external hard disk, 
pen drive, etc. cannot be shredded using Kernel File Shredder. Additionally, it will 
delete only those files that Windows allows to delete. For example, it will not delete 
any file, which is in use but selected to shred. If you select a file, which is in use to 
shred then Kernel File Shredder will not shred the file and failure message is 

reported in the log file. 

 3.1 Salient Features 

Stunning Kernel File Shredder incorporates an array of outstanding features that make it a professional file 
shredding and data privacy tool. Mentioned below are the software features: 

Fast and impeccable Shredding: The software takes just few moments in shredding files and 

folders from computer’s hard disk whereas carrying out impeccable shredding of files and folders. 
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Once the files and/or folders are shredded using Kernel File Shredder, they cannot be recovered 
back by any Data Recovery Software.    

Multiple Shredding Options: The software provides multiple options to let you select and shred 

files and folders in just few clicks. Shredding options provided are: 

1. File and Folder: Enables selecting and shredding files and folders present at different

locations in your computer’s hard disk drive.

2. Recycle Bin: Displays files and folders available in the Recycle Bin folders and allows

shredding them in just one click.

3. System Files: Facilitates shredding Temporary files, Windows Temporary Files, Internet
Temporary Files, and Internet Cookies in just one click.

4. Free Disk Space: Enables shredding free disk space available on hard disk in just one

click.

5. Useless Files: Allows finding and shredding files that are useless for you in just one
click.

Automatic Files Shredding: Kernel File Shredder better understands the importance of time; 

therefore, allows creating and executing file shredding task at prescheduled time. Once the file 
shredding task is created and scheduled, the software will automatically shred files and folders at 
the specified time according to the settings done in the Task.  

Secure Software Access: Whereas Kernel File Shredder is advantageous for those who do not 

want anyone to access their personal and crucial data, it can be otherwise used for destructive 
purposes by offenders. For example, someone who wants to take any sort of revenge from you 
can shred important files from your computer using the File Shredder tool. Therefore, software 
access has been made secure in Kernel File Shredder. To make the application access secure, 
option to set application access password is embedded in the software. Once the password is 
applied, the software can be accessed with correct password only.  

Save Shredding History: The software automatically creates log files in which information about 

the shredding operation is saved. Information like when the shredding operation is performed, 
which option has been selected during the operation, path of the files shredded, which shredding 
algorithm has been used to shred files, whether the shredding process has been successful or not, 
etc. is saved in the log file. That log files help you keep a record of which files was shredded when. 

Save / load Shredding List: Allows you to create a list of the files and folders that you want to 

shred. The list so created will have .cfs format, which can be loaded anytime to carry on the 
shredding process. This feature is beneficial for those who need to shred files on regular basis but 
have lots of other works to do. Such people can simply create a list of the files and folders to be 
shredded and later on when get time, they can upload the shredding list to shred the selected files 
and folders.  
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Multiple Shredding Algorithms: Kernel File Shredder incorporates eleven outstanding File 

shredding algorithms from which the user can select the required one for shredding selected files 
and folders.  

Free Demo: A fully functional yet free version of Kernel File Shredder allows shredding files and 

folders continuously for 30 days without any limitation. However, for using the software after 30 
days, you will have to purchase the Full version of the software.  

Intuitive Graphical User Interface: Both, a professional computer user and novice computer user 

can easily install and use the Kernel File Shredder software because of its self-descriptive 
graphical user interface.  

 4.1  Who Should Use this Software? 

The capability of Kernel File Shredder to delete data beyond recovery makes it appropriate for use by 
professionals, administrators or home users, who have the fear that the confidential files and folders can 
be misused even after permanent deletion.  

Software is the best suitable solution to keep confidential information and data safe. Data removed using 
Kernel File Shredder can never be recovered with any data recovery software. 
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2. Getting Started

Now that you have understood the features and potential of Kernel File Shredder, you are ready to get 
hands on experience of the software. To start shredding files using Kernel File Shredder, you will first 
need to download and install this software. 

It is strongly recommended that before installing Kernel File Shredder, you should go through the 
installation pre-requisites for the software, so that it can be assured that your computer is appropriately 
configured to run the software. 

 1.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel File Shredder are as follows. 

2.1.1 Basic System Requirements: 

Pentium Class Processor  

64 MB RAM (128 MB recommended)  

10 MB free space for software installation 

2.1.2 Supported Windows OS Platforms 

Windows 7  

Windows Vista  

Windows XP  

Windows 2003  

Windows 2000  

Windows 2003 Server  

Windows 2000 Server  

Windows 2000 Advanced Server 

Windows 2008 Server  
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 2.1  Downloading Kernel File Shredder for the First Time 

After checking your computer with the prescribed system requirements for Kernel File Shredder, you can 
download and install the software on your computer.  

If you want to try using Kernel File Shredder before buying it, you can download the evaluation version 
from the following link: 

https://www.nucleustechnologies.com/kernel-file-shredder.html

 3.1 Install Kernel File Shredder 

After downloading the installer file for Kernel File Shredder, you can install the software by running the file. 
To install Kernel File Shredder: 

1. Double-click the Kernel File Shredder installer.

2. Follow the on-screen instructions.

The Setup Installation Complete screen will be displayed. 

3. Click Finish to launch the software.

 Note: When you launch the software after installing it, you are asked to specify
password to make the software access secure. You are suggested to apply a 
password to make the software access secure so that nobody who has access to 
your computer can use Kernel File Shredder for destructive purposes. You can use 
any combination of numbers, alphabets, and special characters as password but 

remember the maximum password length cannot be more than 10 characters. 

 4.1 Start Kernel File Shredder 

To start Kernel File Shredder: 

Click the Start  All Programs Kernel File Shredder 

Alternatively, you can launch Kernel File Shredder by double-clicking the shortcut icon available on the 
desktop and Quick Launch icon. 

 5.1 Uninstall Kernel File Shredder 

You may need to uninstall and re-install Kernel File Shredder. To uninstall Kernel File Shredder: 

1. Click the Start  All Programs Kernel File Shredder  Uninstall Kernel File Shredder

A warning message will be displayed. 

http://www.nucleustechnologies.com/download-file-shredder.html
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2. Click ‘Yes’ to uninstall Kernel File Shredder.

 Before proceeding to uninstall Kernel File Shredder, you must ensure that the
software is not running. 

You can alternatively uninstall Kernel File Shredder from the Control Panel by performing the following 

steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon.

2. Select Kernel File Shredder and click Remove.

A warning message will be displayed. 

3. Click ‘Yes’ to uninstall Kernel File Shredder.

3. Software Interface

Now that Kernel File Shredder has been installed on your computer, you can start using the software after 
getting acquainted with the software interface. 

 1.1 Welcome Screen 

Following is the main screen of Kernel File Shredder. 
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 Figure 3.1: Main Window 

 2.1 Menu Bar 

The Menu bar of Kernel File Shredder comprises following main menus: 

Shred Menu 

View Menu  

Help Menu  



© KernelApps Private Limited

3.2.1 Shred Menu 

Shred menu of the Kernel File Shredder software appears, as shown in following figure: 

Figure 3.2 Shred Menu 

Following table enlists the options available in the Shred menu: 

Option Description 

File and Folder Enables selecting files and folders stored on hard disk for shredding 

Recycle Bin Facilitates shredding files and folders available in the Recycle Bin folder 

System Files Facilitates shredding temporary files, Windows temporary files, Internet 
temporary files, and Internet cookies 

Free Disk Space Enables shredding free space available on computer’s hard disk drive 

Useless Files Enables finding and shredding the files that are meaningless for you 

Exit Select this option to close the software. 

3.2.2 View Menu 

The View menu of Kernel File Shredder is shown in following figure: 
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Figure 3.3 View Menu 

Following table enlists the options available in the View menu: 

Option Description 

Toolbar Hides or displays the tool bar; if selected, software tool bar will be displayed just 
below the menu bar otherwise tool bar is not displayed 

Status bar Hides or displays the status bar; if selected, software status bar will be displayed at 
bottom of the software interface otherwise status bar is not displayed  

Tasks Enables creating/ modifying file shredding tasks for automatic files/folders 
shredding  

Scheduler Enables selecting and scheduling file shredding task for automatic deletion of files 
and folders at the specified time  

Settings Enables configuring default software settings, such as specifying default shredding 
algorithm, configuring settings to create shredding history (log file), and setting 
software secure access password 

3.2.3 Help Menu 

Help menu of Kernel File Shredder is shown in following figure: 
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Figure 3.4 Help Menu 

Following table enlists the options available in the Help menu: 

Option Description 

Help Select this option to view Help manual of the software 

Activate Now Select this option to activate the software; for this you have to provide 
the activation key that will be provided to you with software purchase  

Buy Now Select this option to purchase the software 

About Kernel File Shredder Displays version, support, and sales related information about Kernel 
File Shredder  

 3.1 Tool Bar 

Tool bar consists of buttons that enable you to shred files and folders quickly without navigating the menu 
bar for finding an appropriate option. Following table lists the short cuts available in the Tool bar of the 
software:  
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Option Button 
Name 

Description 

Home Takes you to the software home page 

File and 
Folder 

Enables selecting files and folders stored on hard disk for shredding 

Recycle Bin Facilitates shredding files and folders available in the Recycle Bin folder 

System Files Facilitates shredding temporary files, Windows temporary files, Internet 
temporary files, and Internet cookies  

Free Disk 
Space 

Enables shredding free space available on computer’s hard disk drive 

Useless Files Enables finding and shredding the files that are meaningless for you 

Settings Enables configuring default software settings, such as specifying 
default shredding algorithm, configuring settings to create shredding 
history (log file), and setting software secure access password  

Help Opens the user guide of the software 
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 4.1 Left Pane 

Left pane of Kernel File Shredder provides quick links to perform operations, such as shredding files and 
folders, shredding hard disk free space, creating and scheduling tasks, and configuring software settings. 
Left pane of Kernel File Shredder is shown below: 

Figure 3.5 Left Pane 

 5.1 Right Pane 

Right pane of Kernel File Shredder enables performing shredding operation depending on the option 
selected in the Left pane, Tool bar, or Menu bar. When you launch the software, Right pane appears, as 
shown below: 
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Figure 3.6 Right Pane of Welcome Screen 
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Figure 3.7 Right Pane 
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4. Using Kernel File Shredder

Now that you have complete familiarity of the user interface of Kernel File Shredder, you are ready use the 
software for shredding files. Kernel File Shredder is embedded with various options to shred files and 
folders; these options are:  

Shred File and Folder  

Shred Recycle Bin  

Shred System Files  

Shred Free Disk Space 

Shred Useless Files  

 1.1 Shred File and Folder 

Kernel File Shredder facilitates deleting files and folders beyond recovery. You are suggested to shred 
data instead of deleting, if the data is too much crucial and sensitive. If such important data goes in wrong 
hand then consequences can be too dangerous; therefore, files containing such data shall be shredded so 
that the chances of recovering them become zero. Let’s execute the following steps to shred files available 
on your computer’s hard disk: 

1. Select Start > All Programs > Kernel File Shredder > Kernel File Shredder. If you have specified
password while installing the software, then you are prompted to enter password to access the
software:

Figure 4.1 Enter Password 

 Note: If you have not specified the password, then you are not asked to specify the

password and will be directly taken to the software main window. 
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2. Type the password and click the OK button. The software main window opens up:

Figure 4.2 Software Main Window 

3. Select Shred > File and Folder in the Shred menu or select File and Folder option in the Left pane.

You are provided with an interface to select and shred the required files:
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Figure 4.3 Select Files and Folders 

Here, you are provided with various buttons to perform files and folders shredding related tasks. Following 
table lists the available buttons and their functionalities:  

Button Description 

Enables selecting files and folders from computer’s hard disk 
that you want to shred. 

Most of the times while selecting files and folders to shred, 
user often select some wrong files that s/he does not want to 
shred. To remove those files from the list, just select the file 
(s) and click the Remove button. Multiple files can be
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selecting by holding the CTRL key. 

Enables you remove all files and folders that you have 
selected for shredding.  

Enables you to save the list of files and folders selected for 
shredding. The file in which the list of selected files will be 
saved has .cfs extension. This feature is beneficial when you 
have just listed the files for shredding but suddenly you are 
tasked with another work. At that time, you can save the list 
of selected files and folders and later on by loading the 
saved file, you can continue shredding the selected files and 
folders.  

When you load the .cfs file, you save significant time that 
could have been wasted in selecting files and folders to 
shred once again.  

Enables you load the .cfs file to continue the file shredding 
process. 

Starts the shredding process. 

4. Select files and folders that you want to shred. Selected files and folders will be listed in the “Add file
and folder to shred” list box:
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Figure 4.4 Listed Files and Folders 

5. Select the desired shredding method.

6. Click the Shred button. A message informing you that the deleted data cannot be recovered again

appears:

Figure 4.5 Information Message 
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7. Click the Yes button to continue the shredding process and if you want to add/remove more files then
click the No button. If you click the No button, you can remove/select more files to shred whereas
clicking the Yes button will start the shredding process, as shown in the "Shred File and Folder"

dialog box:

Figure 4.6 Shredding Process 

8. Depending on the files & folders and the shredding method selected, the process may take some
time. Once the process gets completed, Shredding complete message will appear in the Shred File
and Folder dialog box.

9. Click the OK button to close the dialog box.

 2.1 Shred Recycle Bin 

Most of the times, computer users delete files and folders, just by pressing the DELETE key. Items deleted 
using DELETE key, move into the Recycle Bin folder, from where the deleted items can be restored easily. 
Keeping useless items in Recycle Bin after deletion is fine but items that are crucial and sensitive shall not 
be deleted using DELETE key. If any of the person will restore the file having sensitive information and 
use that information in destructive manner then consequences can be riotous. To keep you away from 
such consequences, files and folders moved to the Recycle Bin folder must be shredded so that they 
cannot be recovered again.  
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Kernel File Shredder allows shredding files and folders available in the Recycle Bin folder in just few easy 
steps. Mentioned below are the steps that help you shred files and folders available in the Recycle Bin 
folder: 

1. Select Start > All Programs > Kernel File Shredder > Kernel File Shredder. If you have

specified password while installing the software, then you are prompted to enter password to
access the software.

2. Type the password and click the OK button. The software main window opens up.

 Note: If you have not specified the password, then you are not asked to specify the

password and will be directly taken to the software main window. 

3. Select Shred > Recycle Bin in the Shred menu or select Recycle Bin option in the Left pane. You

are provided with an interface to shred Recycle Bin contents:
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Figure 4.7 Shred Recycle Bin 

4. By default, the software displays files and folders available in the Recycle Bin folder along with their
name, original location, and size. However, if you have deleted some files after selecting the
Recycle Bin option in the software, then click the Refresh button to let the software fetch files and
folders available there:
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Figure 4.8 Select Shredding Method 

5. Select the desired shredding method.

6. Click the Shred button. A confirmation message appears to let you confirm the shredding process:

Figure 4.9 Confirmation Message 
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7. Click the Yes button to continue the shredding process. You can click the No button, if you do not
want to shred the items of Recycle Bin folder. However, if you click the Yes button, the software
starts shredding the files and folders available in the Recycle Bin folder that cannot be recovered
again:

Figure 4.10 Recycle Bin Shredding Process 

 Note: Click the Stop button to discontinue the shredding process.

8. Once the shredding process is complete, the software displays a process completion message.
Click Ok button to close the dialog box.

 3.1 Shred System Files 

Temporary files stored on computer’s hard disk can be a risk to your privacy; therefore, those files shall be 
shredded regularly. Most of the computer users even do not know where temporary files are stored in 
computer’s hard disk so they cannot manually delete them. Kernel File Shredder allows you permanently 
delete Windows Temporary and Internet Temporary files without letting you waste your precious time. 
Mentioned below are the steps that help you shred temporary files: 

1. Select Start > All Programs > Kernel File Shredder > Kernel File Shredder. If you have

specified password while installing the software, then you are prompted to enter password to
access the software.

2. Type the password and click the  OK button. The software main window opens up.

3. Select Shred > System Files in the Shred menu or select System Files option in the Left pane.

You are provided with an interface to shred system files:
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Figure 4.11 Select Option 

4. Default software settings are configured to shred all temporary files, Windows temporary files,
Internet temporary files, and Internet cookies to let you maintain your privacy. However, if you do
not want to shred any particular types of system files then clear the check box besides that type.

5. Select the desired shredding method.

6. Click the Shred button. A confirmation message appears to let you confirm the shredding process:
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Figure 4.12 Confirmation Message 

7. Click the Yes button to continue the shredding process. You can click the No button, if you do not
want to shred system files. However, if you click the Yes button, the software starts shredding

system files that cannot be recovered again:

Figure 4.13 Shredding Process Status 

 Note: Click the Stop button to discontinue the shredding process.

8. Once the shredding process is complete, the software displays the process completion message.
Click Ok to close the dialog box.

 4.1 Shred Free Disk Space 

When users permanently delete file and folders stored on computer’s hard disk using SHIFT + DELETE 
key, they think the files and folders are gone for always. But, this is not at all true. When files and folders 
are deleted from hard disk, Windows operating system marks those files and folders deleted and make the 
hard disk space available for new items. In actual, the files and folders that are marked as deleted are still 
available on hard disk, which means using a good quality data recovery software the items marked as 
deleted can be recovered.  
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This is simply a threat to your privacy because you obviously do not want anyone to access your personal 
files and folders. That is why wiping free disk space is always suggested using a professional file shredder 
so that the deleted files and folders cannot be recovered again. Let us execute the following steps to know 
how to shred free disk space:  

1. Select Start > All Programs > Kernel File Shredder > Kernel File Shredder. If you have
specified password while installing the software, then you are prompted to enter password to
access the software.

2. Type the password and click the OK button. The software main window opens up.

 Note: If you have not specified the password, then you are not asked to specify the

password and will be directly taken to the software main window. 

3. Select Shred > Free Disk Space in the Shred menu or select Free Disk Space option in the Left

pane. You are provided with an interface to shred free disk space:
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Figure 4.14 Select Drive 

4. Select the hard disk partitions to completely wipe the free space available.

5. Select the desired shredding method.

6. Click the Shred button. A confirmation message appears to let you confirm the shredding process:
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Figure 4.15 Process Confirmation Message 

7. Click the Yes button to continue the shredding process. You can click the No button, if you do not
want to shred free disk space. However, if you click the Yes button, the software starts shredding

free disk space:

Figure 4.16 Disk Space Shredding Process 

 Note: Click the Stop button to discontinue the shredding process.

8. Once shredding process is complete software will display the process completion message. Click
Ok to close the dialog box.

 5.1 Shred Useless Files 

Kernel File Shredder allows finding and shredding the files available on your computer’s hard disk that are 
useless for you. Finding and wiping such files has been made easy with Kernel File Shredder. Execute the 
following steps to find and shred useless files:  

5. Select Start > All Programs > Kernel File Shredder > Kernel File Shredder. If you have

specified password while installing the software, then you are prompted to enter password to
access the software.
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6. Type the password and click the OK button. The software main window opens up.

 Note: If you have not specified the password, then you are not asked to specify the

password and will be directly taken to the software main window. 

7. Select Shred > Useless Files in the Shred menu or select Useless Files option in the Left pane.

You are provided with an interface to shred useless Files

Figure 4.17 Select Folders or Drive 

Here, you are provided with various buttons to shred useless files. Following table lists the available 
buttons and their functionalities:  
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Button Description 

Enables specifying path on where you want to locate files 
that you want to shred. 

Starts searching the files available at the specified path. 

Allows you add a filter based on which the software will 
search files available at the specified location. For example, 
if you want to shred all .jpg files then the filter value will be 
*.jpg. You can specify more than one filter. If more filters are 
specified then the software will search the location according 
to all filters one by one depending on their priority.  

Allows you to delete the selected filter. 

Moves the selected filter up in the list to increase its priority. 

Moves the selected filter down in the list to decrease its 
priority. 

Most of the times while selecting files to shred, user often 
select some wrong files that s/he does not want to shred. To 
remove those files from the list, just select the file(s) and 
click the Remove button. Multiple files can be selecting by 
holding the CTRL key.  

Enables you remove all files that you have selected for 
shredding.  

Enables you to save the list of files selected for shredding. 
The file in which the list of selected files will be saved has 
.cfs extension. This feature is beneficial when you have just 
listed the files for shredding but suddenly you are tasked 
with another work. At that time, you can save the list of 
selected files and later on by loading the saved file, you can 
continue shredding the selected files.  

When you load the .cfs file, you save significant time that 
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could have been wasted in selecting files to shred once 
again.  

Enables you load the .cfs file to continue the file shredding 
process. 

Starts the shredding process. 

8. Click the Browse button to select a location where you want the software to search useless files

based on the specified filter. If filter is not specified, the software will list all files available at the
selected location.

9. Click  to specify the filter. 

10. Click the Start Scan button to let the software enlist useless files available at the specified location.

11. Select the desired shredding method.

12. Click the Shred button. A confirmation message appears to let you confirm the shredding process:

Figure 4.18 Warning Message 

13. Click the Yes button to continue the shredding process. You can click the No button, if you do not
want to shred the listed files and want to remove some of them. However, if you click the Yes

button, the software starts shredding the listed files:
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Figure 4.19 Shredding Useless Files 

 Note: Click the Stop button to discontinue the shredding process.

14. Once the shredding process is complete, the software will display the process completion message.
Click Ok to close the dialog box.
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10. Full Version

Although you can use Kernel File Shredder evaluation version for free and experience the capabilities of 
the software but there is some limitation in the evaluation version. 

10.1 Requirement of Full Version 

The trial version of Kernel File Shredder is also available, with which you can evaluate and analyze the 
capabilities of the software. Free version of Kernel File Shredder works similar to the full version i.e. can 
effectively convert up to 50 Word files in .doc and .docx file formats to PDF file format. The free trial 
version of Kernel File Shredder has some limitations i.e. it displays the text Kernel File Shredder Demo 
after every paragraph in converted PDF file. 

10.2 Purchasing Full Version 

You can buy the full version of Kernel File Shredder online. As soon the purchase transaction with our 
resellers gets completed, our sales team will send you an email comprising the URL to download the full 
version of Kernel File Shredder and activation details of the software. 
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11. Support

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel File Shredder. The software comes with an embedded help manual that can be accessed 
by clicking HelpSoftware Help in the menu-bar. You can also press the F1 key on the keyboard of your 
computer to access the embedded help of Kernel File Shredder. 

We have live support wherein you can chat with our software experts at: 

https://www.nucleustechnologies.com/supportcenter/ .

To talk on phone with our software experts call: 

Help line:  

+91-9818725861

1-866-348-7872 (Toll Free for US/CANADA)

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

https://www.nucleustechnologies.com/Online-Helps.html
https://www.nucleustechnologies.com/word/animatedword.html
https://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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12. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel File Shredder. 

12.1 Common Issues 

Why does Kernel File Shredder have limitations in evaluation copy? 

The free evaluation version of Kernel File Shredder is intended to enable you to experience the 
capabilities of the software. You will need to buy the software to have the demo stamp deleted from 
converted file. 

12.2 Frequently Asked Questions 

How to Buy Kernel File Shredder? 

You can buy Kernel File Shredder online at https://www.nucleustechnologies.com/buy-word-to-pdf.html

I have lost my full version for Kernel File Shredder. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

How can I upgrade the software? 

To upgrade the software you have to send an email to sales@nucleustechnologies.com. Please include 

your name, address, email address, order confirmation number and the name of the software upgraded to. 

Would I get an invoice for my purchase? 

Yes, we provide every customer with a soft copy of the invoice. This is sent on the same day, on the 
provided email. 

https://www.nucleustechnologies.com/buy-word-to-pdf.html
mailto:sales@nucleustechnologies.com
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13. Legal Notices

This section comprises the legal specification about Kernel File Shredder and the company 
KernelApps Private Limited 

13.1 Copyright 

KernelApps Private Limited, Kernel File Shredder accompanied user manual and documentation 
are copyright of KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user 
manual cannot be reproduced in any form without the prior written permission of KernelApps Private 
Limited. No Patent Liability is assumed, however, with respect to the use of the information contained 
herein. 

© KernelApps Private Limited. All rights reserved. 

13.2 Trademark 

Kernel File Shredder ® is a copyright work of KernelApps Private Limited 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS and Open Office 
are registered trademarks of Microsoft Corporation and Sun Microsystems, Inc. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

13.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. KernelApps Private Limited provides no warranty with regard to this manual 
or any other information contained herein and here by expressly disclaims any implied warranties 
of merchantability or fitness for any particular purpose with regard to any of the foregoing 
KernelApps Private Limited assumes no liability for any damages incurred directly or indirectly from 
any technical or typographical errors or omissions contained herein or for discrepancies between the 
product and the manual. In no event shall KernelApps Private Limited, be liable for any incidental, 
consequential special, or exemplary damages, whether based on tort, contract or otherwise, arising 
out of or in connection with this manual or any other information contained herein or the use there of. 

13.4 License Agreement 

Kernel File Shredder copyright © by KernelApps Private Limited 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing 
this software, unless you have a different license agreement signed by KernelApps Private Limited. 
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The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 
Kernel File Shredder. For purposes of this License, if you have a valid license, you have the right to use a 
single Licensed Copy of Kernel File Shredder. 

Scope of License 

Each Licensed Copy of Kernel File Shredder may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Kernel File Shredder, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by KernelApps Private Limited. You may not rent, lease, modify, translate, 
reverse engineer, decompile, disassemble, or create derivative works based on, Kernel File 
Shredder, nor permit anyone else to do so. You may not make access to Kernel File Shredder available to 
others in connection with a service bureau, application service provider, or similar business, nor 
permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel File Shredder, and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Kernel File Shredder, must be thoroughly 
tested with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all 
use of the copies of Kernel File Shredder covered by this License. This disclaimer of warranty 
constitutes an essential part of this License. In addition, in no event does KernelApps Private Limited 
authorize you or anyone else to use Kernel File Shredder in applications or systems where Kernel File 
Shredder failure to perform can reasonably be expected to result in a significant physical injury, or in 
loss of life. Any such use is entirely at your own risk, and you agree to hold KernelApps Private 
Limited harmless from any and all claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements 
and arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction 
and venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, 
and you consent to such jurisdiction and venue. There are no third party beneficiaries of any 
promises, obligations or representations made by KernelApps Private Limited herein. 

Any waiver by KernelApps Private Limited of any violation of this License by you shall not constitute, 
nor contribute to, a waiver by KernelApps Private Limited of any other or future violation of the same 
provision, or any other provision, of this License. 




